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COPYRIGHT 

Gerber AccuMark ©2023 Lectra SA and its affiliates. All rights reserved.   

This document may not be reproduced by any means, in whole or in part, without the written permission of the 

copyright owner.  

This document is part of the proprietary articles furnished to document Lectra SA and its affiliates support for 

Gerber AccuMark. 

In consideration for the furnishing of the information contained in this document, the party to whom it is given 

assumes its control and custody and agrees to the following:  

The information contained herein is given in confidence and any part thereof shal l not be copied or reproduced 

without the written consent of Lectra. 

This document or the contents herein under no circumstances shall be used in the manufacture or reproduction 

of the articles shown, and the delivery of this document shall not constitute any right or license to do so. 

 

TRADEMARKS 

Gerber AccuMark is a registered trademark of Lectra in the United States, all rights reserved. Other company 

names, brand names and product names mentioned in this document are trademarks or registered trademarks 

of their respective companies.  

DISCLAIMER 

The information contained in this document is subject to change without notice. Lectra SA and its affiliates  

shall not be liable for errors in this document or for incidental or consequential damages in connection with 

furnishing or use of this material, including, for example, loss of profits, fabric, and production time.  
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GERBER ACCUMARK® 3D:  

WHAT’S NEW FOR APRIL 2023 

 

HIGHLIGHTS 

In AccuMark 3D v16.0 users will find the following new features and improvements streamlining your workflow.   

 Reorganization of 3D 

o Open in 3D from the File Menu 

o Updated Ribbon  

 Recolor Avatars 

 Multi-Dimension Grading 

 Posable Virtual Alvaforms  
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1. REORGANIZATION OF 3D 

New organization of the 3D ribbon tabs simplifies your workflow.  

1.1 Open in 3D 

Open your 3D model directly from the File Menu. There is no longer a 3D tab in the 2D 

workspace 

 

 

If you prefer a button to press to Open in 3D, we recommend adding it to the Quick Access Toolbar 

by selecting the down arrow in the toolbar > Select More Commands. 
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1.2 New 3D Lines Tab 

The 3D tab from the 2D workspace is now a 3D Lines Tab in the 3D workspace. Users no longer 

need to save and return to 2D to access the fold and elastic functions. The functions continue to 

be available only in pre-simulation. All the functions in Folds, Elastics, Cut-lines, and Split Piece 

have all been moved. 

 

 

The view fold, elastic, and cut functions can be used with a saved or running simulation. Only the 

view functions are available in a multiple model workspace.  

1.2.1 Fold Lines 

Create and delete Fold, Collar and Accordions directly in the 3D workspace. Update the 

fold parameters, select the line(s) to apply the fold, and highlight the side to fold in the 3D 

workspace. Turn on View to display the fold parameters in the 3D workspace for lines 

with folds.  

 

The line highlights with region of fold parameters in both 3D workspace and 3D window. 

 

NOTE: For more information on collars, refer to the AccuMark 3D v10.1 What’s New documentation 
in C:\ProgramData\Gerber Technology\Training Docs\AccuMark Documentation\Whats New Previous 
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Select side to fold.  

 

In create Accordion, the pins to adjust the range display in the 3D workspace. The 

selected line highlights in both 3D workspace and 3D window.   
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1.2.2 Elastic Lines 

Create elastic lines in both the 3D workspace and in the 3D window. 

 

While selecting the line to apply elastic, the preview displays in both the 3D workspace 

and 3D window. Turn on View to display the elastic parameters in the 3D workspace on 

lines with elastic.  

1.2.3 Cut Lines 

Apply a cut line attribute to an internal line in the 3D workspace or 3D avatar window. In 

the 3D window, the piece will visually update to show a cut line. The piece in the 3D 

workspace will have a label “Cut” when a cut line is present and view select is on.  
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1.2.4 Split Lines  

The split line function separates a piece on an internal line. This split function will add the 

new pieces to the model; complete with 3D information, position the pieces in the 3D 

workspace, and sew them together automatically. Line selection occurs in both 3D 

workspace and 3D avatar window. 

1.2.5 Highlighting of 3D Lines 

Lines selected in 3D lines functions highlight. The selected line highlights as well as the 

extent of the fold or elastic diameters. The default color is black. The select a new color: 

1. Edit > Workspace > Customize > Dropdown to Preferences 

 

2. Navigate to the Color Tab 

3. Find Near > click on color box to change color.  

 

4. Apply updates the change for the current session and save updates the change 

for current and future sessions.  
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1.2.6 New Function in 3D: 2-point Line  

2-point lines help to create folds, elastics and placing trims. To access, navigate to the 

3D Toolbar > Create Lines > 2-Point line.  

 

 

Line displays in 3D workspace and 3D window at same time. In the above picture, the 

line is drawn in the 3D window. 

1.3 3D Ribbon & Toolbar Reorganization 

1.3.1 Sizes 

To align with the new field of “Garment Size” to support multidimensional grading, the 

current sizes dropdown is now in the sizes panel of the 3D Ribbon.  

1.3.2 Improvements 

During an active or saved simulation, the Edit Tab > Workspace Panel > Customize > 

Preferences is now available.  
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2. RECOLOR AVATARS 

Recolor your avatars in Gerber AccuMark 3D. If an avatar has multiple textures all textures update to a 

single color. Alvanon Virtual Alvaforms are prohibited from being recolored. The icon in the ribbon includes 

a color band that is the same color as the selected avatar color. If the avatar has not been recolored,  

including avatars with textures; the band will be a default grey color.  
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2.1 Default Color Palettes 

Two default color palettes are available for recoloring, a Skin-Like color palette and a Grey scale. 

Tooltips show the RGB value of each color. 

2.1.1 Skin-Like Color 

The skin-like colors are comparable to a store mannequin color and not a realistic skin 

tone. We do not recommend using the recolor avatar function if you are trying to achieve 

life-like appearance. In Gerber AccuMark 3D, users can only select a single color to 

represent their avatar. 

RGB (84, 66, 57) RGB (84, 67, 56) RGB (99, 75, 63) RGB (101, 77, 62) RGB (119, 86, 66) RGB (137, 95, 77) 

      

RGB (153, 106, 88) RGB (155, 119, 93) RGB (174, 127, 110) RGB (179, 136, 110) RGB (173, 139, 111) RGB (183, 146, 123) 

      

RGB (189, 149, 132) RGB (184, 154, 126) RGB (194, 163, 143) RGB (199, 166, 148) RGB (199, 168, 150) RGB (200, 172, 153) 
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2.1.2 Grey Scale 

Some users prefer to use a greyscale color for their avatars in order to highlight the 

garment features. The second default palette is a greyscale. 

RGB (0,0,0) RGB (26, 26, 26) RGB (40, 40, 40) RGB (51, 51, 51) RGB (77, 77, 77) RGB ( 102, 102, 102) 

      

RGB (128, 128, 128) RGB (153, 153, 153) RGB (179, 179, 179) RGB 204, 204, 204) RGB (230, 230, 230) RGB (242, 242, 242) 

      

 

2.2 Create Color  

Select create color to bring up the color wheel dialog and create your own custom color.  

In the standard tab, select a color from the honeycomb display.  In the custom tab, enter 

your own color value. Use the color picker to select a color on screen.  
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2.3 Reset Avatar Color 

Remove the selected color and return to the avatar’s default color.   

 

2.4 Remove Custom Color 

There is a limit of 18 custom colors. Once the limit is reached, a message will prompt 

indicating the limit and to add more you must remove a color from the list.  

 

 

2.5 Saving 

A recolored avatar maintains its color when it is included in the export simulation options of glTF 

or glb. The recolored avatars are not supported in OBJ exports or simulations sent to YPLM.  

 

Default Color Skin-Like Grey Custom 
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3. MULTI-DIMENSION GRADING 

AccuMark 3D now supports multi-dimension grading to show different garments sizes based on the grade 

dimensions for your model. 

“Garment” is a new field in the sizes panel of the ribbon to support Multi-Dimensional Grading in 3D.  

 

3.1 Selecting Garment Size 

To change the garment to a different size line:  

1. Select the three ellipses.  

 

2. A matrix selection displays with the all available dimensions. The asterisk (*) indicates the 

base size.  

 

  



 

GERBER ACCUMARK 3D 

 

Gerber AccuMark 3D is a registered trademark of  Lectra. Other trademarks 
mentioned in this document are the property  of  their respectiv e owners.  

 
lectra.com 16/23 

 

3. Select one size in each grade dimension. Multiple selection is not supported.  

 

4. Press ok button to confirm selection. 

5. Alternatively, users may enter text directly into the text field.  

 

If only D1 is available in the model then only D1 will display.  The 3D Model Garment Properties selection 

for Graded Avatars only displays the D1 sizes. D1 is the default dimension in 3D regardless of the active 

dimension in 2D. 
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Base Size 

 

Multi-Dimension Size 

 

  



 

GERBER ACCUMARK 3D 

 

Gerber AccuMark 3D is a registered trademark of  Lectra. Other trademarks 
mentioned in this document are the property  of  their respectiv e owners.  

 
lectra.com 18/23 

 

3.2 Images 

The image functionality in 3D is available while using the base size dimensions of the current or 

garment size. 

3.3 Multi Model Simulation 

Multi Model Simulations lets you use models with multi-dimension grading. The matrix selection is 

available in the multiple model selection dialog to accommodate models that have more than 1 size 

dimension.  

When a model contains multi-dimensions the default is set the model’s base sizes. To change the 

graded size: 

1. Find the row for the desired model 

2. In the graded size column, select the three ellipses (…).  

3. The Matrix Selection dialog displays allowing the selection of the sizes in the available 

dimensions 

 

 

 

  

NOTE: For more information on multi-dimensional grade, refer to the AccuMark PE v12 What’s New 
documentation in C:\ProgramData\Gerber Technology\Training Docs\AccuMark Documentation\Whats 
New Previous 

 



 

GERBER ACCUMARK 3D 

 

Gerber AccuMark 3D is a registered trademark of  Lectra. Other trademarks 
mentioned in this document are the property  of  their respectiv e owners.  

 
lectra.com 19/23 

 

4. ALVANON POSABLE ALVAFORMS 

Gerber AccuMark 3D now supports Alvanon Posable Alvaforms. Use the “Change Pose” icon 

in the 3D Toolbar to select your desired pose sequence. This icon unavilable for static Alvanons 

and all other non-posable Alvanon Alvaform. Select the pose in pre-simulation.  

4.1 Poses 

We support 9 poses, Wide-A Pose, T Pose, A Pose, Regular (arms down), Arms Forward, Arms 

Up, Casual (asymmetric contrapposto), One Leg Up, and Squat. The default pose is Wide-A. To 

change the start pose, remove wide-A from the dialog and add desired. If no pose sequence is 

determined, there will be no movement during simulation. The Reset to Default button cancels out  

current selection of poses and brings back to the default Wide A Pose.  

4.2 Simulation 

Alvanon avatars have a lot of mesh detail on them causing more time spent in the simulation. Each 

pose takes a different amount of time to finish simulating. If all poses are selected, the total frame 

count will be 274 for the avatar to reach final pose. Based on garment type, the garment can finish 

simulating prior to the avatar reaching its final pose. The frame count each pose is on is as follows:  

 Frame 1: Wide A Pose 

 Frame 18: T Pose 

 Frame 44: A Pose 

 Frame 55: Regular 

 Frame 95: Arms Forward  

 Frame 136: Arms Up  

 Frame 197: Casual 

 Frame 22: One Leg Up 

 Frame 274: Squat 

 

 

4.3 Animation Speed 

Users can adjust the animation speed of Alvanon posable avatars. The default is 1.0. Minimum is 

0.1 (speed reduction) and maximum is 10.0 (speed increase). An increase in animation speed 

reduces the overall number of frames it takes to complete the avatar animation. A decrease in 

animation speed increases the number of frames it takes to complete the avatar animation.  

Increasing speed, depending on model, it is possible the avatar collides with the garment causing 

collisions. If this occurs we suggest reducing the speed and/or adjusting piece positioning.  Along 

with the pose sequence, the Reset to Default button resets the animation speed back to 1.0.   
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Wide A T Pose A Pose 

   
Regular Arms Forward Arms Up 

  

 
Casual One Leg Up Squat 

  
 

  

NOTE: For more information on Alvanon Avatars, refer to the AccuMark 3D v13.2 What’s New 
documentation in C:\ProgramData\Gerber Technology\Training Docs\AccuMark Documentation\Whats 
New Previous 
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5. VIEW CLIP IMAGES 

Starting with v16.0 users can clip images in AccuMark 2D Pattern Design. AccuMark 3D supports the 

display of clip images in the 3D workspace and 3D Avatar window. Users can move, delete or edit  

properties of the trim images and delete the line associated with clip image. Creating clip images in the 

3D workspace is not supported yet and the icon in the ribbon is disabled. Return to 2D to create and 

modify. 

 

 

 

 

NOTE: For more information on Clip Image Function, refer to the AccuMark PE v16.0 What’s New 
documentation in C:\ProgramData\Gerber Technology\Training Docs\AccuMark Documentation\Whats 
New Previous 
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6. IMPROVEMENTS 

6.1 Pleats 

More pleats display and simulate in AccuMark 3D.  

6.1.1 Converted Pleats 

Converted pleats that are variable or tapered, in a box or knife, have the correct shape in 

3D. For pleats converted in the previous software versions, return to 2D > close the pleat  

then reopen > save in 2D > reopen the model in 3D. 

6.1.2 Pleat Lay Side 

Variable and tapered pleats that use a movement side of both are now supported in 3D.  

6.2 Selection 

Improvements have been made to different selections in the 3D window. Pin placement and 

management now avoid placement through the avatar to the other side. Rotate the avatar to place 

or manage pins on the other side of the avatar or piece.  

The Move Accessory function now allows interaction with the width through the avatar after the 

accessory is selected 

The Move Cylinder function now allows interaction with the cylinder grips through the avatar after 

the cylinder is selected 

6.3 Colorways 

In 3D, users can now use undo and redo when creating colorways.  

6.4 OBJ Export 

Improvements have been made to the obj output file for accessories. For each textured accessory, 

now only one copy of the image is included in the output file even if the same accessory is used 

multiple times.  
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6.5 Export Images 

Exported Images from render preview now clips the image down to the smallest bounding box 

available eliminating excess background image.  

 

 

 

 

NOTE: For more information on exporting images, refer to the AccuMark 3D v14 What’s New 
documentation in C:\ProgramData\Gerber Technology\Training Docs\AccuMark Documentation\Whats 
New Previous  

 


